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CorelDRAW merupakan salah satu pengolah grafis dengan basis vektor, dimana unsur dasar yang 

mendasarinya adalah garis. Keuntungan dari vektor ini adalah gambar akan mempunyai ukuran 

kapasitas file yang relatif kecil apabila dibandingkan dengan pengolah grafis berbasis bitmap. Juga 

tidak ada penurunan kualitas jika gambar diperbesar. 

Namun demikian, versi X7 sudah menyertakan filter­filter efek pengolah bitmap dalam fungsi 

tersendiri. Yang dapat dipakai untuk memanipulasi penataan objek dalam sebuah komposisi gambar 

yang diinginkan. Apapun program grafik yang dipakai, semuanya terpulang pada kreatifitas dan 

imajinasi pemakainya. 

 
Workspace / Area Kerja 

 
Sewaktu membuka program, inilah beberapa lokasi penting yang perlu diperhatikan :

 
 

 
A. Daftar Menu Program  

Berbagai perintah pengoperasian mulai dari menyimpan file, membuka file, mengatur ukuran 

halaman, dan menampilkan berbagai menu bantuan.  
B. Icon Command Shortcut  

Berisi icon-icon jalan pintas (shortcut) pengoperasian berbagai perintah penting dari daftar 

men u program.
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C. Tools Options / Property Bar  
Isi bar ini adalah property dari tool box dan akan berubah-ubah sesuai dengan jenis tool 

yang dipakai dan macam objek yang tengah dipilih. Isinya tidak jauh dari berbagai fitur 

pengoperasian tambahan yang dimiliki oleh sebuah tool.  
D. Tool Box  

Berisi berbagai peralatan untuk membuat berbagai macam objek gambar dan fitur 

tambahan yang berhubungan dengan kualitas visual gambar (warna, garis dan efek). 

E. Ruler  
Penggaris bantuan yang dapat dipakai sebagai panduan dalam menentukan batas-batas 
area penataan objek.  

F. Canvas  
Tempat mencurahkan segala bentuk kreatifitas gambar yang dibuat.  

G. Dockers  
Ekspansi atau menu tambahan dari beberapa perintah menu dan juga tool box yang 

sedang aktif. Lokasinya bisa dipindahkan, disembunyikan atau bahkan ditutup.  
H. Color Bar/Pallette  

Bar untuk menentukan pewarnaan garis (outline) dan isi (fill) objek.  
I. Information Box  

Sebagai bar informasi mengenai objek yang sedang aktif.  
J. Page Control  

Mengontrol tampilan halaman pada sebuah dokumen yang memiliki banyak halaman.  
K. Cursor Position  

Menunjukkan posisi kursor dalam perhitungan ukuran yuang sama pada penggaris (ruler).  
L. Window Control  

3 (tiga) buah ikon untuk menyembunyikan, membesarkan/mengecilkan  
dan menutup windows canvas (dokumen). Berguna sewaktu bekerja dengan banyak 
dokumen. 

 
 
 
 

Beberapa jenis istilah pada CorelDRAW :  
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Tool Box CorelDRAW 
 

No. Icon Fungsi 

1 

 
Pick Tool (V) 

Memilih, memanipulasi dan 
mengontrol objek. 

2 

 
Shape Tool (F10) 
 

 

Memanipulasi objek kurva 
 Shape Tool, untuk mengedit 

suatu outline/kurva. 
 Smudge Brush, untuk 

mengubah bagian garis 
outline pada objek dengan 
cara drag pada outline. 

 Roughen Brush, digunakan 
untuk mengubah bagian 
outline pada garis vektor dari 
objek 

 Tranform Tool, untuk 
memutar objek dengan 
bebas. 

3 

 
Knife Tool  

Berguna untukmemotong suatu 
objek. 
TIPS 
Klik pada satu sisi lalu klik pada sisi 
lainnya. Hasil potongan dapat 
langsung terlihat. 

4 
 
Eraser Tool (X) 

Untuk menghapus sisi objek. 

 
5 

 

 
Zoom Tool (Z) 
 
Hand Tool (H) 

Memperbesar – memperkecil 
ukuran tampilan pandangan. 

Menggeser tampilan layar. 

6 

 
Jika user ingin membuat bentuk sendiri 
maka bentuk objek tersebut berbentuk 
kurva (Curve) baik tertutup yang dapat diisi 
warna / fill 
maupun yang terbuka yang tidak dapat 
diisi warna. 

Tool-tool vital untuk membuat 
gambar dengan bentuk yang sesuai 
dengan keinginan user. 
Freehand, untuk menggambar 
kurva bentuk bebas. 
Bezier  , untuk menggambar 
kurva Bezier yang mempunyai 
handle untuk mengendalikan 
bentuk kurva. 
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6 

 
Lihat ilustrasi di halaman berikut… 
 

Artistic Media, untuk 
menggambar kurva yang 
mempunyai bentuk artitstic. 

Pen, sama seperti Bezier Tool 
namun lebih fleksibel. 

Polyline, sama seperti Bexier 
Tool dan Pen Tool. 

3 Point Curve, membuat kurva 
terbuka lengkung yang presisi. 
ƒ  Connector, untuk membuat 
konektor antar objek. 
ƒ 
Dimension, membuat 
keterangan dimensi objek. 
Fungsi Connector dan Dimension 
tidak dijelaskan melalui ilustratsi di 
samping. 
 
PENTING! 
Tool yang sering digunakan untuk 
membuat sebuah bentuk objek baik 
itu berupa kurva terbuka/tertutup 
adalah Freehand, Bezier dan Pen. 
. 

 

 

 
Smart Fill 
Smart Drawing 
(Shift+F5)  

Smart Fill berfungsi untuk 
memberi warna fill secara 
mudah dan cepat. 

Smart Drawing berfungsi untuk 
membuat gambar secara cepat 

7 

  
 
Rectangle (F6) 
3   Point Rectangle 

Rectangle, untuk membuat 
gambar kotak. 
ƒ 
3 Point Rectangle, untuk 
membuat gambar kotak yang 
berawal dari satu sisi. 
TIPS 
Untuk membuat bentuk sama sisi 
yang presisi, tekan Ctrl. Untuk 
membuat dari titik tengah tekan 
Ctrl+Shift. 
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Ellipse (F7) 
3 Point Ellipse 

 
Ellipse, untuk membuat 
lingkaran. 
 
3 Point Ellipse , untuk membuat 
lingkaran yang berawal dari satu 
sisi. 
TIPS 
Untuk membuat bentuk sama sisi 
yang presisi, tekan Ctrl. Untuk 
membuat dari titik tengah tekan 
Ctrl+Shift. 

10 

 
 

Polygon (Y) 
Star 

Complex Star 
Graph Paper (D) 

Spiral (A) 
 
 

 

 
 Polygon, untuk membuat 
 gambar segi banyak. 

 
 Star, untuk membuat bintang. 

 
 Complex Star, untuk membuat 
 bintang dengan sisi menyilang. 
 Graph Paper, untuk membuat 
 kotak yang terbagi dari beberapa 
 grid. 
 Spiral, untuk membuat spiral. 

TIPS 
Untuk membuat bentuk sama sisi 
yang presisi, tekan Ctrl. Untuk 
membuat dari titik tengah tekan 
Ctrl+Shift. 

11 

 
Tool-tool yang 
berguna untuk 
membuat objek-
objek 
primitif pada 
umumnya atau 
objek dasar. 

Tool-tool yang sangat mudah 
digunakan, silahkan dicoba sendiri. 
Di dalam masing-masing tool ini 
masih terdapat bermacam-macam 
shape/bentuk dasar yang siap 
pakai. 

12 

  
Text Tool (F8) 

Text Tool berfungsi untuk 
mengetikkan suatu teks atau 
paragraph. 

 

  
Table tool 

Berfungsi untuk membuat tabel 
yang dapat diisi teks/data seperti 
program aplikasi pengolah angka 
(spreadsheet). 
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Interactive Efect 
Tool, user dapat 
melihat & 
mendapatkan 
efek yang diinginkan 
secara cepat dengan 
cara mengatur 
settingnya secara real 
time. 
 

 
 

ƒ  Interactive Blend Tool, 
berfungsi untuk membuat 
peralihan dari satu bentuk objek 
ke bentuk objek yang lain. 
Bentuk kedua objek akan 
bercampur manjadi satu. 

ƒ  Interactive Contour Tool, 
berfungsi untuk 
memperbesar/memperkecil 
ukuran suatu objek. 

ƒ  Interactive Distrot Tool, sangat 
bermanfaat untuk ‘merusak’ 
bentuk suatu objek sehingga 
menghasilkan bentuk objek lain 
yang berbeda. 

ƒ  Interactive Drop Shadow Tool, 
untuk menambahkan efek 
bayangan di bawah satu objek. 

ƒ  Envelope Tool, untuk 
membentuk suatu objek seolah- 
olah objek tersebut terbungkus 
oleh suatu bentuk. 

ƒ  Extrude Tool, untuk memberi 
efek 3 dimensi dari objek 2 
dimensi. 

ƒ  Transparency Tool, memberikan 
efek transparan pada suatu objek. 

 

 

 Eyedropper Tool, untuk 
mengambil warna dari suatu objek. 
Paintbucket Tool, mengisi 
warna ke suatu objek. 

 

Segala atribut yang 

berkaitan dengan 

outline suatu kurva 

atau 

shape diatur lewat 

menu 

ini. 

 Outline Pen akan menampilkan 
kotak dialog Outline Pen seperti 
gambar di samping bawah. 

 Outline Color akan 
menampilkan kotak dialog Color. 

INFO 
Sebuah outline dapat memiliki 
ketebalan setebal rambut (Hairline), 
½ point, 1 point, 2 point dan 
seterusnya atau juga tidak memiliki 
ketebalan alias tanpa outline. 
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Tool-tool vital lagi di 

CorelDRAW untuk 

colouring (pewarnaan 

dan 

beberapa efek) pada 

objek yang berupa kurva 

tertutup. 

 Uniform Fill, untuk mengisi 

warna fill / blok warna pada 

suatu kurva tertutup. 

 Fountain Fill, untuk mengisi fill 

warna gradasi. 

 Pattern Fill, utnuk memberikan 

patter atau pola. 

 Texture Fill, untuk mengisi 

tekstur pada suatu objek. 

 PostScript Fill, untuk 

memberikan efek postscript. 

 None, menghilangkan fill pada 

suatu objek. 

PENTING: 

Selalu gunakan warna CMYK jika 

hasil gambar akan dicetak atau 

dikirim ke percetakan. 

Penggunaan mode warna RGB 

hanya untuk menampilkan gambar 

di display monitor saja. 
  

Interactive Fill (G) 

Mesh Fill (M)  

 Interactive Fill, salah satu 

kelebihan CorelDRAW adalah 

ada banyak cara untuk mengisi 

warna pada suatu objek kurva 

tertutup. Dengan tool ini 

pengisian warna tidak harus 

dengan cara seperti di atas 

karena bersifat interaktif artinya 

user dapat langsung 

mengendalikan proses  

pewarnaan & melihat hasilnya. 

 Mesh Fill, berguna untuk 

memberi gradasi pada area 

tertentu pada suatu objek. 

INFO 

Tool Mesh Fill bermanfaat juga 

untuk pembuatan gambar 

berkualitas foto (Photorealistic). 
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Property Bar CorelDRAW 

 
Seperti telah disebutkan di atas, masing-masing tool pada CorelDRAW mempunyai properti atau 

atribut tersendiri yang bermanfaat untuk pengaturan lebih lanjut oleh user. Atribut / property tersebut 

berada di Property Bar yang letak defaultnya ada di atas.  
 

 
Analogi sebuah Property Bar adalah jika kita ingin menerbangkan pesawat maka 

yang akan kita hadapi adalah kokpit pesawat beserta instrumen-instrumennya. 

Begitu juga jika kita ingin mengemudikan mobil maka yang akan kita hadapi 

adalah dashboard mobil beserta kemudinya. 
 

 

Berikut ini beberapa Property Bar berdasarkan tool yang dipakai dan sangat bermanfaat untuk 

pemakaian sehari-hari : 

Property Bar Pick Tool   
 
 

Berguna untuk merubah atribut halaman kerja, mulai dari ukuran halaman, orientasi, unit dan lain-
lain. 

Property Bar Shape Tool   
 
 

Biasa dipakai jika kita mengedit sebuah kurva, garis, outline atau sebuah shape/bentuk. 
 

Property Bar Free Transform Tool   
 
 

Sangat bermanfaat untuk mentransform (merubah orientasi objek) secara cepat, mulai dari 

menggeser, memutar, merefleksi, memperbesar/kecil, memiringkan sebuah objek. 

Untuk proses transformasi suatu objek secara cepat disarankan menggunakan property bar Free 

Transform Tool ini. 

Property Bar Zoom & Hand Tool   
 

 

Bermanfaat untuk memperbesar / memperkecil pandangan area kerja atau objek yang terseleksi. 
 

Property Bar Artitstic Media Tool   
 

 

Berguna untuk mengatur settingan ketebalan, kelembutan dan gaya dari media lukis kita seperti 

kuas, alat semprot (spray), kaligrafi dan airbrush (Pressure). 

 

Property Bar Rectangle Tool   
 
 

Salah satu keunggulan CorelDRAW adalah 

pembuatan Round Corner dengan radius berbeda tiap 

sudutnya. Di property bar Rectangle ini hal itu dapat 

dengan mudah dilakukan.  
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Property Bar Ellipse Tool   

 

Ini juga merupakan salah satu keunggulan CorelDRAW dalam pembuatan objek lingkaran dengan 

gaya berbeda dengan mudah seperti lingkaran utuh, berbentuk pie dan juga lingkaran putus. 
 
 
 
 

 
Property Bar Polygon, Star, Complex Star, Graph Paper & Spiral Tool  

 
 
 
 
 

 

Property bar yang mengatur semua settingan untuk objek berbentuk polygon, star, complex star, 

graph paper & spiral. 

 

Property Bar Basic Shapes    
Cara termudah menggambar suatu bentuk sederhana di 

CorelDRAW adalah dengan menggunakan Basic Shape. Model-

model shape dapat diakses lewat property bar-nya. Lihat gambar di 

samping.  
Untuk Arrow Shape, Flowchart Shape, Banner Shape & Callout 

Shape dapat dilakukan dengan cara yang sama.  
 
 

Property Bar Text Tool  
 

 

Property bar yang mengatur atribut-atribut teks seperti jenis, style dan ukuran font atau juga 

perataan paragraf. 
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Latihan 1 
 

Membuat Objek-Objek Sederhana 

 
1. Buatlah objek-objek seperti di bawah ini menggunakan fasilitas Basic Shapes.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Buatlah beberapa garis sederhana dengan ketebalan dan style garis yang berbeda 

menggunakan Freehand, Bezier dan Pen Tool.  
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Buatlah objek Rectangle, Elipse, Star, Complex Star, Polygon dan Spiral tanpa & 

menggunakan kombinasi tombol Ctrl dan Ctrl+Shift.   
4. Mini Project.  

Buatlah sebuah objek Rectangle & teks yang terdiri dari teks dan pragraf seperti contoh berikut   
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Menggambar Bentuk 
 

Mempersiapkan Area Kerja  
 
 
 

 

Sebelum berkreasi, ada baiknya mengatur dulu ukuran halaman atau dokumen baru. Halaman adalah 

area tempat objek yang akan dicetak juga tempat kita menggambar sedangkan area di sekeliling 

halaman kita boleh menempatkan corat-coret objek. Lihat gambar di atas untuk acuan. 
 
 

Membuat Objek  
Setiap objek yang dibuat akan terdiri dari area isi (fill) dan garis luar (outline). Dalam kondisi default 

objek terdiri dari isi warna transparan dan garis luar warna hitam. Dalam pembuatan objek ini berlaku 

fungsi-fungsi mouse (klik, drag & drop) serta kombinasi antara fungsi mouse dengan tombol Ctrl, Alt 

dan Shift. 

 
ƒ Untuk membuat objek yang presisi sama sisi tekan Ctrl ketika drag. (berlaku untuk Rectangle, 

Ellipse, Star, Complex Star, Spiral & Polygon).  
ƒ Untuk membuat objek dari titik tengah, tekan Shift ketika membuat objek.  
ƒ Jika telah selesai membuat sebuah Rectangle, Ellipse, Star, Complex Star, Spiral & Polygon, 

cobalah bereksperimen dengan Shape Tool (F10) untuk mendapatkan bentuk lain yang lebih 
variatif.  

 

 

P E N T I N G !  
Untuk mendapatkan bentuk objek yang diinginkan, ketika membuat objek 

menggunakan tool bar jangan lupa untuk mengatur masing-masing settingan lewat 

Property Bar dari masing-masing tool bar seperti yang sudah dijelaskan pada bab 

sebelumnya. 
 
 

 
ƒ Kotak 

o Klik ikon Rectangle tool .  
o Klik lalu  tahan – geser – lepaskan (pada area canvas).  
o Jika ingin membuat round-corner, tekan F10 lalu 

drag salah satu kotak hitam (lihat gambar di 
samping). 

 
 
 
 

 

ƒ Lingkaran 

o Klik ikon Ellipse tool .   
o Klik lalu tahan – geser – lepaskan (pada area canvas) 



  
 

Modul Multimedia Corel Draw - LPKP Albar College   

 

 
 
  
 

ƒ Polygon  

o Klik ikon Polygon tool .  
o Klik lalu tahan – geser – lepaskan (pada area canvas) 

  
ƒ Spiral  

o Klik dan tahan ikon Polygon tool sampai muncul  

Spiral .  
o Klik lalu tahan – geser – lepaskan (pada area canvas) 

  
ƒ Star  

o Klik dan tahan ikon Polygon tool sampai muncul  

Star .  
o Klik lalu tahan – geser – lepaskan (pada area canvas) 

 
ƒ Basic Shape 

o Klik ikon Basic Shape .   
o Klik lalu tahan – geser – lepaskan (pada area canvas) 

 
ƒ Kurva  

o Klik ikon Freehand, Bezier atau Pen.   
o Klik beberapa kali pada area kerja. Khusus 

Pen klik dua kali untuk mengakhiri kurva.  
o Klik pada awal kurva dibuat jika ingin menutup 

kurva (membuat kurva tertutup).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Untuk dapat merubah kurva ke bentuk yang kita inginkan, jangan lupakan Property Bar dari Shape  
Tool!  
Berikut penjelasannya : 

•  Symmetrical Node: kotak kanan ditarik kotak kiri ikut bergerak secara simetrik. Atau 
juga bisa membuat node bersudut tumpul. 

•  Smooth Node: kotak kanan ditarik kotak kiri tidak ikut bergerak, tapi jika kotak 

kanan ditarik ke atas dan kebawah kotak kiri ikut bergerak, begitu juga sebaliknya. 
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•  Cusp Node : Kotak kanan ditarik ke kanan/kiri atas/bawah kotak sebelahnya tidak 
terpengaruh. Atau bisa juga membuat node bersudut tajam.  

•  Convert  to Curve: merubah garis kedalam bentuk kurva sehingga garisnya bisa 
diubah/edit menggunakan Shape Tool .  

•   Convert  to Line: merubah kurva kembali kebentuk garis. 

•  Break Curve/ Join Two Nodes: memutuskan simpul/Node atau menyambungkan 
dua simpul/Node. 

•   Add Node / Delete Node: Menambah Simpul baru atau menghapus Simpul. 
 

Berikut ini adalah contoh penerapan pembuatan objek yang melibatkan peran Property Bar 
Shape Tool.  

 
 
 
 
 
 
 
 
 
 

ƒ Teks & Paragraf (Text Frame) 

o Klik ikon Text Tool.  
o Klik pada area kerja. Lalu ketikkan teks yang 

diinginkan.  
o Klik lalu drag pada area kerja untuk membuat 1 

paragraf teks. Ukuran paragraf dapat diatur 
seperti mengatur bentuk Rectangle.  

o  Perataan teks (Left, Center, Right & Even) dapat 

diatur melalui icon  di Preperty Bar Text Tool. 

 
Salah satu contoh bentuk paragraf teks yang bentuknya 

divariasikan dan dipecah menjadi 3 paragraf. 
 

 
 
 
 
 
 
 
 
 
 

 

Contoh teks 1 baris non-paragraf : 
 

 
 
Contoh teks Text Frame / berparagraf :  
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Mentransformasi Objek  
Setelah belajar bagaimana caranya membuat objek (menggambar) maka tahap selanjutnya adalah 

bagaimana objek-objek yang telah kita gambar tersebut ditransformasikan. Seperti digeser, diperbesar-

perkecil bentuknya, diputar (rotasi), dimiringkan dan direfleksikan (efek cermin). 
 
 

ƒ Menggeser Objek  
o Klik Pick Tool sampai muncul 

8 kotak hitam kecil di 
sekeliling objek.  

o Pilih objek yang ingin digeser.  
o Lalu drag ke posisi yag diinginkan. 
o Bila menginginkan posisi baru  

yang sejajar dengan yang 

lama, tahan Ctrl ketika drag.  
o Bila ingin menduplikasi objek 

ketika menggeser, klik kanan 
selesai drag. 

 
ƒ Merubah dimensi objek  

o Pilih objek yang ingin dirubah 
dimensinya.  

o Drag salah satu dari 8 kotak hitam  
sampai ukuran yang 

diinginkan terpenuhi.  
o Bila ingin menduplikasi objek 

ketika merubah dimensinya, 
klik kanan selesai drag. 

 
ƒ Memutar Objek  

o Pilih objek yang ingin putar.  
o Klik sekali lagi sehingga 8 kotak 

hitam berubah menjadi gambar 
panah berputar.  

o Drag sampai posisi putaran yang 
diinginkan terpenuhi.  

o Bila ingin menduplikasi objek 
ketika memutarnya, klik 
kanan selesai drag. 

 
 
 
 
 
 
 
 
 

 

TIPS :  
Jika ingin menduplikasi objek dengan nilai step 

tertentu, tekan Ctrl+D lalu masukkan nilai 

pergeserannya. Misalnya, ingin menduplikasi objek 

setiap 5 mm. 
 
 
 
 
 
 
 
 
 
TIPS :  
Jika ingin merubah dimensi objek dapat juga dengan 

menggunakan tool Free Transform Tool  di tool box.  
 
 
 
 
 
 
 
 
 
 

 

TIPS :  
Jika ingin memutar objek dapat juga dengan 
menggunakan  

tool Free Transform Tool  di tool box. Titik pusat 

putaran akan sangat bergantung dari di mana kita 

pertama kali mengklik objek.  
 

ƒ Memiringkan Objek  
o Pilih objek yang ingin miringkan. 
o Klik sekali lagi sehingga 8 kotak 

hitam berubah menjadi gambar  
panah berputar. 

o Drag pada panah 

horizontal/vertical. 
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Merefleksikan Objek  
o Pilih objek yang ingin dicerminkan. 

o Klik icon . 
 
 

 

TIPS :  
Jika ingin merefleksikan objek dapat juga dengan  

menggunakan tool Free Transform Tool  di tool 

box. Titik pusat cermin akan sangat bergantung dari di 

mana kita pertama kali mengklik objek. 
 

 

Prioritas Urutan Objek 
 

Pengertian proritas objek di sini adalah objek mana yang akan muncul paling atas atau bawah jika 

terjadi penumpukan beberapa objek. Jika kita membuat banyak objek maka objek yang pertama kali 

dibuat akan berada pada tumpukan terbawah/terakhir sedangkan objek yang terakhir dibuat akan 

berada pada tumpukan teratas. Jika kita menginginkan objek yang kita buat muncul paling atas atau 

paling bawah atau mungkin bergeser satu tingkatan maka diberlakukan Stacking Order/urutan objek. 
 
 

Cara mudah merubah urutan objek adalah :  
ƒ Klik objek lalu tekan Ctrl+Page Down jika 

ingin memindahkan objek ke belakang atau 

ƒ tekan Ctrl+Pg Up jika ingin 
memindahkan objek ke depan. 

 
Jika klik kanan pada objek lalu pilih Order, akan 

ada beberapa pilihan urutan objek :  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Namun jika kita tersesat dalam ribuan objek yang saling bertumpuk satu sama lain maka cara 

mengatur objek yang paling mudah adalah dengan menggunakan Layer. Layer dapat diakses lewat 

menu Windows -> Dockers -> Object Manager. Berikut ini contoh Object Manager yang menghandle 

ratusan objek. Objek-objek tersebut terbagi ke dalam beberapa layer untuk memudahkan 

pengaturan.Kita dapat fokus ke suatu layer sehingga objek-objek di dalamnya tidak mengganggu 

objek-objek di layer yang lain. 
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Perataan Objek 
 

Masih dalam pembahasan manajemen atau pengaturan objek, kali ini kita akan mengatur perataan 

objek agar terlihat rapi. Perataan atau alignment biasanya terjadi jika kita menggunakan satu objek 

sebagai tolok ukur perataan objek-objek lainnya. 

 
Perataan objek terdiri dari Rata Kanan (R), Kiri (L), Tengah (C), Atas (T) dan Bawah (B).  

 
Salah satu syarat perataan objek-objek adalah ada 

satu objek yang menjadi tolok ukur perataan  
sehingga objek-objek yang lain dapat 

mengikutinya. Objek yang terakhir diklik akan 

menjadi tolok ukur perataan. 
 
 
 
 
 
 
 
 

 

Cara meratakan objek: Contoh objek-objek rata kanan : 

Pilih  beberapa  objek,  lalu  klik  icon di    
Property  Bar,  kotak  dialog  Align  &  Distribute 
akan muncul. Pilih perataan yang diinginkan.  

 
 
 
 
 
 
 

Membentuk Ulang Objek 

 
Sering kita menghendaki objek-objek yang sudah ada ingin dibentuk ulang sehingga menghasilkan 

objek baru namun dengan bentuk yang kurang lebih sama alias tidak jauh berbeda dengan aslinya. Di 

CorelDRAW kita dapat membentuk ulang objek-objek yang sudah ada dengan cara : 
 
 
 
 

 

ƒ Weld (mengelas/menyambung objek)  

ƒ Trim (memotong mengikuti bentuk objek pemotong)  

ƒ Intersect (mendapatkan gambar perpotongannya)  

ƒ Simplify (gambar tumpukan teratas memotong gambar di bawahnya)  

ƒ Front Minus Back  dan Back Minus Front   
ƒ  

ƒ  Membuat objek baru berdasarkan outline gabungan dari kedua buah objek. 
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Selain dengan cara di atas, pengaturan objek yang biasa dilakukan adalah dengan mengelompokkan 

objek atau Groupping. Caranya, pilih/seleksi beberapa objek lalu tekan Ctrl+G. Pengelompokkan 

berguna untuk memudahkan pengeditan secara serentak ke beberapa buah objek gambar. Jika ingin 

menguraikan objek yang digroup cukup tekan Ctrl+U pada objek yang tergroup tersebut. 
 
  

Alat-Alat Bantu Menggambar 

 
Suatu artwork yang hebat merupakan sebuah hasil proses yang panjang. Meliputi proses kreatif mulai 

dari pencarian ide, sketsa, sampai final artwork. Selain tool-tool atau alat-alat yang sudah disebutkan 

di atas, masih ada lagi beberapa alat bantu menggambar di CorelDRAW. 

 
Mereka adalah :  

ƒ Ruler  
Satuan Ruler atau penggaris dapat kita tentukan lewat Property Bar Pick Tool. Centimeter, 

milimeter, meter, pixel, point dan lain-lain.  
Cara menampilkannya/menyembunyikannya cukup masuk ke View -> Ruler.  
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ƒ Grid  
Bermanfaat agar objek-objek di area kerja kita lebih teratur. Teruatama untuk Alignment atau 

perataan. Cara menampilkannya/menyembunyikannya cukup masuk ke View -> Grid.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ƒ Guidelines  
Tool yang sangat vital karena dengan guideline semua objek dapat diatur menurut garis pandu 

yang telah kita tentukan sebelumnya. Cara membuatnya cukup drag Ruler/penggaris ke area 

kerja kita. Menampilkannya/menyembunyikannya cukup masuk ke View -> Guidlines. 
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Latihan 2 
 

Membuat Objek-Objek Sederhana 

 
1. Membuat logo sederhana.  

Buatlah teks KREATIKA MAGAZINE, gambar kotak persegi panjang warna hitam di bawah 
teks  
KREATIKA.  

 
 
 
 

 
Tool yang digunakan adalah Rectangle Tool (F6)  dan Text Tool (F8) . 

 

2. Membuat daun secara sederhana menggunakan Bezier Tool .  
o  Klik mulai dari titik 1, 2 lalu diakhiri di titik 3. 

o Gunakan Shape Tool  lalu klik salah satu titik lalu klik icon Convert Line To Curve 

 untuk membuat garis menjadi lengkungan. 

o  Lalu warnai daun tersebut.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. Membuat stempel menggunakan fasilitas Weld  .  
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4. Membuat logo TOYOTA menggunakan fasilitas Combine . Setelah selesai, ratakan 

ketiga objek tersebut menjadi rata tengah secara vertikal. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

5. Membuat teks mengikuti alur sebuah kurva 
(path). o Buatlah beberapa ‘potong’ teks. 
o  Buat juga sebuah lingkaran. Teks akan mengikuti alur lingkaran.  
o  Klik teks yang akan dirubah alurnya lalu klik Text -> Fit Text To Path.  
o  Arahkan kursor mouse ke sebuah lingkaran atau kurva/path yang dituju.  
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Mewarnai Bentuk 
 

Setelah kita berkenalan dengan tool-tool di CorelDRAW dan telah mempelajari bagaimana caranya 

menggambar di CorelDRAW, sekarang kita akan mempelajari bagaimana caranya mewarnai objek-

objek yang telah kita buat. 

 
Warna terdiri dari 2 jenis yaitu  

ƒ Warna solid atau warna blok.  
Di CorelDRAW warna solid/blok dikenal dengan nama Uniform Fill.  

 
 
 
 
 
 
 
 
 
 

 

ƒ Warna gradasi (transisi suatu warna ke warna yang lain) Di 

CorelDRAW gradasi dikenal dengan nama Fountain Fill.  
 
 
 
 
 
 
 
 
 
 

 

Sedangkan menurut letaknya ada 2 jenis warna, yaitu :  
ƒ Warna Fill (Uniform Fill)  

Warna yang mengisi area objek atau kurva tertutup. Kurva atau objek terbuka tidak dapat 

diberi warna fill.  
 
 
 
 
 
 
 

 

ƒ Warna Outline / Line  
Warna yang berada di sekeliling objek.  
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Ada berbagai macam cara mewarnai objek di CorelDRAW namun ada 2 cara yang termudah yaitu : 

 
ƒ Melalui Color Docker.  

 
Cukup klik objek yang akan diberi warna kemudian klik salah satu warna 

yang dikehendaki di Color Docker. Contoh Color Docker lihat gambar di 

samping. Default warna yang tersedia adalah warna CMYK. Namun kita 

masih dapat memilih skema warna yang lain seperti RGB, PANTONE 

dan lain lain.  
 

 
Mewarnai fill objek cukup klik pada warna yang dikehendaki, 

namun jika ingin mewarnai Outline klik kanan pada warna 

yang dikehendaki. 
 
 
 
 
 
 
  
 
 

Mewarnai Objek Dengan Gradasi 

 
Warna gradasi adalah transisi dari suatu warna ke warna yang lain. Gradasi juga dapat memberikan 

sensasi tersendiri pada objek yang diwarnai karena dapat menimbulkan kesan dimensi atau adanya 

ruang yang terdapat pada suatu objek. 

 
A. Berikut ini langkah-langkah mewarnai objek dengan warna gradasi menggunakan kotak dialog 

Fountain Fill. 

 

1. Klik text tool   
2. Ketikkan kalimat MULTIMEDIA 

 
 
 
 
 

3. Masih dalam keadaan terseleksi, teks MULTIMEDIA kita jadikan Curve.. Tekan Ctrl+Q. 

Beri warna fill dan outline dengan Black 100 % (C=0, M=0, Y=0, K=100). 
 
 
 
 

 
4. Tekan F11 sehingga terbuka kotak dialog Fountain Fill …  

Untuk menambah warna-warna baru di antara kotak hitam dan putih cukuk double klik di 

antara kedua kotak tersebut. Masing-masing segitiga mengandung satu warna. 
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5. Klik Ok. Hasil akhir seharusnya seperti gambar di bawah ini. 
 
 
 
 
 
 

6. Jika suatu objek sudah pernah diisi warna gradasi lalu ingin diedit kembali gradasinya, cukup  

dengan klik icon Interactive Fill Tool  di tool bar lalu pilih Linear. Kemudia kursor mouse 

akan berubah menjadi slider bertanda panah tempat kita mengatur setting warna gradasi. Di 

property bar-nya pun ada parameter yang dapat kita isi, mirip dengan parameter yang ada di 

kotak dialog Fountain Fill. 
 
 
 

Property Bar Interactive Fill Tool  
 

Jenis – jenis Gradasi ( Fountain Fill )  
 
 
 
 
 
 
 
 
 

 
Linear Radial  

 
 
 
 
 
 
 
 
 
 

 

Conical Square  
 

 

B. Cara membuat gradasi menggunakan Interactive Fill Tool  .  
1. Buat sebuah objek.  

 
 
 
 
 
 
 
 
 
 

 

2. Klik icon Interactive Fill Tool . Property Bar yang bersangkutan akan muncul (lihat gambar 
paling atas halaman ini).  

3. Klik Linear pada pilihan Fill Type.  
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4.Slider gradasi akan muncul. Jika slider ini muncul berarti kita bebas menentukan 

bentuk dan arah gradasi sesuai keinginan kita. 
 

5. Ganti warna gradasi (Fountain Fill) dengan merah dan hijau. 
 

 Prinsip dasar gradasi = Transisi dari warna apa ke warna apa. 

 
6. Drag kotak warna pada slider ke mana saja sesuai keinginan kita.  

 
 
 
 
 
 
 
 
 
 
 
 

7. Double klik di titik-titik sepanjang slider gradasi. Titik-titik inilah yang akan berisi warna 

baru selain warna yang sudah kita tentukan sebelumnya (merah & hijau). Sehingga objek 

tersebut nantinya akan berisi lebih dari 2 warna gradasi.  
 
 
 

 
Memilih warna baru cukup  
lewat property bar 

 
 
 
 
 

8. Slider gradasi dan titik-titik warna masih dapat digeser atau dipindah.  
 

Mewarnai Objek Dengan Gradasi Mesh Fill 

 
Selain mewarnai gradasi dengan cara di atas, masih ada lagi cara membuat gradasi yang jauh lebih 

canggih dan fleksibel yaitu menggunakan teknik Mesh. Fasilitas ini bermanfaat jika kita ingin 

membuat gradasi pada area tertentu saja sehingga gambar dapat seperti foto sungguhan. 

Area tertentu tersebut adalah point-point dan segment atau titik dan segmen dimana masing-masing 

titik dan segmen dapat ditentukan kandungan warnanya. 

Cara membuat gradasi Mesh dengan Interactive Mesh Fill Tool : 

 
1. Buat sebuah objek. 

2. Lalu klik icon Interactive Mesh Fill Tool .  
3. Objek akan berisi titik-titik yang mana satu titik tersebut dapat diisi warna. Sesuaikan handle dan 

posisi titiknya seperti kita mengedit sebuah kurva. 
  
 

Satu titik = satu warna.
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Open Curved & Closed Curved 

 
Dalam Coreldraw, ada beberapa macam obyek. Secara garis besar ialah :  

ƒ Primitives atau Basic Shapes  
ƒ Text  
ƒ Effects  
ƒ Curve  
ƒ Bitmap. 

 
Pembuatan objek yang sesuai dengan keinginan sang designer dapat dimungkinkan dengan 

pembuatan kurva (Curve). Baik itu kurva terbuka atau pun kurva tertutup. Yang paling mendasar 

adalah obyek yang berjenis curve. 

ƒ Kurva mudah diedit secara manual.  
ƒ Kurva biasanya langsung disertai outline. outline tersebut dapat dibuat transparan.  
ƒ Kurva dapat diperoleh dengan membuatnya dengan curve tools (bezier, freehand, dsb).  
ƒ Kurva juga dapat diperoleh sebagai konversi dari primitives, teks, dan effects.  
ƒ Kurva dapat dikonversi menjadi obyek bitmap sehingga tidak dapat diedit lagi. 

 
Latihan  

1. Buatlah sebuah objek berbentuk rectangle lalu beri fill dan outline.  
2. Duplikasi rectangle tadi dengan tombol [+] pada numeric pad keyboard.  
3. Nudge atau geser salah satunya sehingga letak kedua rectangle berdampingan.  
4. Pilih rectangle yang kanan dengan pick tool, lalu tekan Ctrl+Q. 

 
Jika berhasil, meskipun tampaknya tetap serupa, minimal ada dua perbedaan yang dapat anda 

perhatikan.  
Pertama, jika anda tunjuk dengan pick tool, masing- masing object menunjukkan property bar yang 

berbeda satu sama lainnya. Ini adalah sebagai akibat bahwa pada saat menekan Ctrl+Q, kita 

merubah salah satu rectangle menjadi curve. Jadi mengingat bahwa isi dari property bar tergantung 

jenis obyek, dan pick tool dapat kita anggap bersifat netral, maka jelas property bar akan 

menampilkan isi yang berbeda jika anda memilih sebuah rectangle dibanding bila anda memilih 

sebuah curve, yang sudah tentu memiliki Property Bar sendiri.  
 

Hal kedua yang dapat kita amati adalah 
seperti ditunjukkan oleh gambar.  
Tampak bahwa memindahkan control 
points pada sebuah curve (meskipun 
merupakan hasil konversi dari rectangle), 
menghasilkan bentuk yang berbeda dengan 
jika anda melakukan hal yang sama 
terhadap rectangle.  

 
TIPS :  
Untuk membuat sudut lengkung pada 
Rectangle cukup seleksi rectangle lalu tekan 
F10. Kemudian geser salah satu sudutnya 
sampai bentuk sudut yang diinginkan 
terpenuhi.  

 
Tekan Ctrl+Q untuk merubah objek dasar / basic shape & teks menjadi Curve 

agar mudah diedit bentuknya. 
 

 

 



  
 

Modul Multimedia Corel Draw - LPKP Albar College   

 

 
Open Curve 

 
Open Curve atau kurva terbuka tidak dapat berisi warna karena hanya terdiri dari oultine atau garis 

atau juga segmen.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Angka = Node / Simpul, Huruf = Segmen 

 
Node   
Berikutnya, kita akan membicarakan tentang node. 

Perlu diketahui bahwa ada tiga macam node: Cusp, 

Smooth, dan Symmetrical.  
 

Cusp adalah satu- satunya jenis node yang dapat 

membentuk sudut tajam. Pada contoh tampak node 

dengan jenis cusp, membentuk sudut antara segment 

line dan curve.  
 

Symmetrical adalah node tidak bersudut atau tumpul 

yang mempunyai handle yang simetris atau sama panjang 

pada kedua ujungnya.  
 

Sedangkan Smooth mempunyai handle node yang tidak 

sama panjang kedua ujungnya.  
 
 

 

Menambah atau mengurangi node dapat dilakukan dengan klik icon   atau    pada property 
bar  
Shape Tool atau double klik pada sebuah segmen.  
Untuk contoh lihat gambar berikut :  
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Closed Curve 

 
Closed Curve atau kurva tertutup dapat berisi warna dan pembuatannya kurang lebih sama dengan  
Open Curve. Lihat penjelasan berikut untuk : 

 
Pembuatan Closed Curve dari Open Curve.  

 

1 Klik icon Extend 2 
 Curve to Close  

. 

 

Atau Join Two Nodes . 
 

 

Pembuatan Closed Curve langsung.  
 

2  
1 

 
 
 
 
 
 
 

Membuka Close Curve 
Close Curve atau kurva terutup dapat dibuka sehingga menjadi Open Curve. Icon yang digunakan 
adalah  

Break Curve   .  
 
 
 
 
 
 
 
 
 
 
 
 

 
LATIHAN  
Buatlah gambar seperti di bawah ini (kurva tertutup).  
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Pengolahan Objek Tingkat Lanjut 

 
Selain mempunyai kemampuan menggambar, CorelDRAW juga dibekali dengan kemampuan 

pengolahan objek tingkat lanjut. Seperti : 
 

 
Blend 

 
Pengertian BLEND adalah pencampuran 2 bentuk objek sehingga membentuk objek baru yang 

ditentukan oleh langkah atau step. 

 
Berikut ini langkah-langkah untuk membuat objek dengan efek Blend.  

1. Buat 2 buah objek dengan bentuk yang berbeda. 

2. Seleksi kedua objek tersebut lalu klik icon Interactive Blend Tool  di tool box. 

Ingat, penekanan icon ini akan mengaktifkan Property Bar dari tool yang bersangkutan. 

 
 
 
 

3. Keterangan dari masing-masing parameter :   
Menentukan jenis-jenis blend. 

 
Menentukan apakah hasil blend berdasarkan jumlah step atau jarak 

per objek.  
Menentukan jumlah step dan jarak objek antar blend (dengan satuan 

unit). 
 

Menentukan arah blend. 
 

Menentukan akselerasi objek yang diblend. 
 

Opsi blend tambahan seperti memecah blend dari objek induk. 
 

Menghapus efek blend pada suatu kumpulan objek
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Berikut ini cara membuat blend yang mengikuti alur sebuah curve / path : 
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Contour 

 
CONTOUR digunakan jika kita ingin membuat objek beranak pinak dengan dimensi atau ukuran 

yang lebih kecil atau lebih besar dari aslinya namun masih dengan bentuk yang sama seperti 

induknya. 

 
Berikut ini langkah-langkah untuk membuat objek dengan efek Contour.  

1. Buat sebuah objek  

2. Seleksi objek tersebut lalu klik icon Interactive Contour Tool . Ingat, penekanan icon 

ini akan mengaktifkan Property Bar dari tool yang bersangkutan.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Keterangan dari masing-masing parameter lihat contoh kasus di bawah..  
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Envelope 

 
ENVELOPE bermafaat untuk membuat bentuk objek seperti terbungkus oleh sesuatu. 

 
Contoh kasus aplikasi Envelope sederhana pada sebuah objek (gambar-gambar efek Envelope di 
bawah  

menggunakan Interactive Envelope Tool  ) :  
 
 
 

 

Envelope Straight 

Line Mode 
 
 
 
 
 
 

Kombinasikan dengan 

penekanan tombol 

Ctrl, Alt, Shift atau 

Ctrl+Shift untuk hasil 

yang 

bervariatif.  
 

Envelope Single 

Arc Mode  
 
 
 
 
 

Kombinasikan dengan 

penekanan tombol 

Ctrl, Alt, Shift atau 

Ctrl+Shift untuk hasil 

yang 

bervariatif.  
 

Envelope 

Double Arc 

Mode 
 
 
 
 
 

 
Kombinasikan dengan 

penekanan tombol 

Ctrl, Alt, Shift atau 

Ctrl+Shift untuk hasil 

yang 
 
 



  
 

Modul Multimedia Corel Draw - LPKP Albar College   

 

 
 

bervariatif.  
 

Envelope  
Uncontrained Mode  

 
 
 
 
 
 
 
 
 
 
 
 

Contoh lainnya :  
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Extrude 

 
EXTRUDE merupakan penerapan bentuk 3 dimensi (3D) sebenarnya dari sebuah objek 2 dimensi, 

berbeda dengan ENVELOPE. Karena dalam Extrude ada penambahan titik kordinat Z selain X dan Y. 

 

Buatlah sebuah objek lalu klik icon Interactive Extrude Tool  yang akan memunculkan property 

bar-nya. Tentukan jenis extrude melalui Preset, lalu masukkan ketebalan objek yang terekstrude. 

Geser slider Extrude sampai menuju bentuk 3D yang diinginkan. Lihat gambar – gambar di bawah ini.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Icon-icon yang menentukan bentuk 3D ialah :  
 

Extrusion Type & Extrusion Depth, menentukan jenis extrusi dan tingkat 

ketebalan extrusi.  
VP (Vanishing Point), apakah diambil dari objeknya saja, berbagi 

vanishing Point dengan objek Extruded lain atau dari halaman.  
Extrude Rotation, memutar objek yang sudah terekstrude. Bermanfaat 

jika ingin menampilkan objek dari angle / sudut pandang yang berbeda.  
Color, menampilkan warna pada objek terekstrude apakah 

menggunakan warna bayangan atau ada warna lain yang dimasukkan.  
Bevel, menampilkan bevel atau semacam list yang bersifat artistik 

di sepanjang garis outline.  
Lighting, pencahayaan yang akan diterapkan ke objek yang 

terekstrude agar lebih realistik. 

 
Satu lagi fasilitas di CorelDRAW untuk membuat efek 3D sederhana namun terkesan elegan adalah 

membuat angle perspektif dengan cara klik pada objek yang bersangkutan lalu klik menu pull down 

Effects - > Add Perspective.  
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PowerClip 

 
POWER CLIP bermanfaat untuk memasukkan objek baik itu vektor atau bitmap ke dalam sebuah 

objek lain atau disebut container. Hasilnya adalah objek di dalam objek. 

 
Cara menggunakannya :  

1. Sebelumnya harus ada 2 buah objek, objek pertama adalah objek isi (content) lalu objek yang 

kedua adalah objek penampung (container).  
2. Klik objek yang akan dijadikan isi (content).  
3. Lalu klik menu pulldown Effects -> PowerClip -> Place Inside Container…  
4. Lalu pilih menggunakan kursor panah besar objek penampung (container) yang akan 

menampung objek isi tersebut. 

 
Seperti terlihat di gambar berikut ini :  

 
 
 
 
 
 
 

Objek texture = content,  
Objek Text (harus diconvert terlebih dahulu menjadi kurva) = container.  

 
 
 
 
 
 
 

Objek texture masuk ke dalam objek text. 
 

Objek Raster Di CorelDRAW 

 
CorelDRAW memang ditujukan untuk membuat dan mengolah gambar berbasiskan vektor. Namun 

tidak tertutup kemungkinan untuk mengolah gambar raster atau bitmap. Jika ada satu artwork yang 

membutuhkan gambar raster maka CorelDRAW sanggup mengolahnya di dalam interface atau antar 

muka program CorelDRAW itu sendiri tanpa bantuan software/program pengolah khusus foto seperti 

Adobe Photoshop atau Corel PHOTOPAINT. Tentu saja dengan kemampuan yang terbatas untuk 

mengolahnya, tidak bisa melakukan hal-hal rumit seperti penerapan special effect pada foto. 

 
Jika ingin serius dalam mengolah foto apalagi dengan penambahan special effect disarankan 

menggunakan software terpisah seperti yang telah disebut di atas. Jika terpaksa dikerjakan di 

CorelDRAW maka hasilnya akan kurang optimal. 

 
Selain kemampuan membuat gambar vektor, CorelDRAW juga mampu membuat dan menghasilkan 

gambar raster/bitmap seperti untuk keperluan web, animasi, wallpaper dan lain-lain. 
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Import File Bitmap/Raster 

 
Lalu apa yang akan kita lakukan jika dalam suatu proyek dibutuhkan gabungan antara grafik vektor 

dan bitmap (raster). Pada CorelDRAW hal ini bukan masalah. Kita dapat membuat grafik vektor pada 

CorelDRAW lalu mengimport atau mengambil file grafik bitmap agar disatukan dalam suatu kesatuan 

artwork.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Berikut ini cara menyatukan gambar raster/bitmap ke dalam artwork berbasikan vektor di CorelDRAW 
:  

1. Buka dokumen baru atau dokumen CorelDRAW yang sudah ada. 

2. Klik icon Import..  atau tekan Ctrl+I.  
3. Kotak dialog Import File terbuka. Pilih file raster/bitmap yang ingin kita masukkan ke dalam 

dokumen kita.  
4. Tentukan lokasi penempatan objek raster/bitmap tersebut pada artwok kita lalu klik.  
5. Objek raster/bitmap sudah menyatu pada dokumen kita.  
6. Objek raster akan berada pada urutan teratas. Gunakan context menu (klik kanan) Order lalu 

pilih Back One (Ctrl+PgDn).  
7. Jika ingin mengedit gambar raster tersebut dapat menggunakan menu pull down Bitmap.  

 
 
 
 
 

Satu hal yang harus diingat adalah semakin banyak dan besar objek raster yang kita import maka 

akan semakin besar ukuran file kerja kita. Ini berpengaruh langsung pada kecepatan komputer. 
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Export File Bitmap/Raster 

 
Seperti telah disebutkan di atas, selain dapat menghasilkan file vektor, CorelDRAW juga dapat 

menghasilkan file bitmap atau format vektor lain untuk beberapa keperluan. Cara ini disebut dengan 

Export, artinya kita menghasilkan file gambar selain berformat standar CorelDRAW (.cdr). 

 
Berikut cara mengekspor gambar ke format lain :  

1. Seperti biasa, artwork atau gambar yang kita buat di CorelDRAW harus sudah terbuka.  
2. Klik menu pull down File -> Export.  
3. Kotak dialog Export akan terbuka.  
4. Silahkan pilih format file yang diinginkan. Lalu klik Ok.  
5. Jika kita akan menyimpan ke dalam bentuk bitmap maka akan ada lagi kotak dialog, yaitu 

Convert To Bitmap.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

6. Lalu klik Ok untuk mengekspor artwork. 
 

 

Kenapa Gambar Harus Diexport? 

 
Karena : 

 
ƒ Jika kita ingin mengirimkan gambar ke orang lain yang tidak mempunyai program 

CorelDRAW di komputernya, orang tersebut nasih dapat melihat gambar kita.  
Misalnya, mengirim surat lamaran beserta CD portfolio dalam bentuk file Jpeg.  

ƒ Jika kita ingin membuat gambar yang akan dimuat ke dalam situs web.  
Situs web mengharamkan penampilan format gambar selain format Jpeg, GIF, PNG dan SVG.  

ƒ Memasukkan gambar kita ke dalam program lain agar dapat mudah dibaca dan dipakai. 
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Menu Dockers 

 
At last but not least, menu Dockers. Menu yang secara default berada pada sisi kanan interface 

program CorelDRAW, berdampingan dengan Color Palette.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cara mengakses menu Dockers dengan klik Window -> Dockers. Contoh menu Dockers yang  
Lalu pilih menu yang akan di-docking. terbagi dari beberapa tab. 

 
Fungsi parameter yang berada pada Dockers tidak berbeda dengan menu di Property Bar, hanya ada 

beberapa perbedaan dalam cara penanganan objek. Karena keduanya memang berisi beberapa 

parameter yang digunakan untuk pengolahan suatu objek namun dengan cara yang berbeda. 

 
Lihat gambar berikut :  
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Gambar di atas adalah gambar Star dengan Property Bar-nya. 

Property Bar berisi beberapa pengaturan / parameter setting untuk 

gambar Star yang bersangkutan. Sedangkan gambar di samping 

adalah menu Docker yang berisi Object Properties dari gambar Star. 

 
Kesimpulan: Jadi suatu objek mempunyai settingan parameter 

masing-masing di dua tempat: 
• di Property Bar dan  
• di Object Properties. 

 

 

Menu-Menu Dockers 

 
Berikut beberapa contoh penggunaan menu Dockers :  

1. Rotasi Objek  
 

Pada menu Dockers – 

Transformation, klik icon Rotate. 

Masukkan nilai Angle 12 deg. 

Lalu Klik Apply To Duplicate 

beberapa kali sampai gambar 

seperti di bawah terbentuk.  
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2. Shaping / Membentuk Objek  

 
Seperti sudah dijelaskan pada 

bab terdahulu, menu Shaping 

terdiri dari beberapa fungsi 

untuk membentuk objek baru 

: 

ƒ Weld  
mengelas/menyambung  
objek.  

ƒ Trim memotong mengikuti  
bentuk objek pemotong.  

ƒ Intersect mendapatkan 

gambar perpotongannya.  
ƒ Simplify gambar tumpukan 

teratas memotong gambar 
di bawahnya.  

ƒ Front Minus Back  
ƒ Back Minus Front 

 
 
 
 
 
 
 
 
 
 
 
 
 

Selain menu-menu Dockers, masih ada lagi beberapa menu Dockers.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Berfungsi untuk mengoplos warna

 
 


